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(1) How to setup Cadence before the first use 
 
 
Set up your working directory: 
 
To setup the cadence environment for your VLSI2 account run the cadence_setup script  from a command prompt: 
 
vlsi2%   mkdir cadence2 
vlsi2%   cd cadence2 
vlsi2%   cp /usr/local/cadence2/NCSU_1.4/NCSU.cshrc_cadence2_IC5141  
         NCSU.cshrc_cadence2_IC5141 
 
 
(To run Cadence from a PC see section (4) of this document) 
 
(Open a terminal window on the VLSI lab workstation by right clicking the mouse on the blue desktop back-
ground, then click on the toolsmenu, then click on terminal to open a new terminal window.) 
 
To use NCSU design kit you need to source ncsu.cshrc in the current terminal window: 
 
 vlsi2%   cd cadence2 
  vlsi2%   source NCSU.cshrc_cadence2_IC5141 
 
start  icfb by typing the following in your working cadence directory: 
 
 vlsi2%   icfb& 
 
In order to quit CADENCE select File and Exit from the Cadence Log window(CIW).  
A message window appears to confirm your command.  
 
Select OK to exit. 
 
For Further information on creating a library, a schematic, and running  
a simulation in Cadence see the following link:  
 
NOTE: The information in this link is not specific to the vlsi2 server. 
  
http://www.fulton.asu.edu/ets/services/services/server/unix/Cadence.php 
 
 
 
 

    Cadence documentation is available online. To open it type: 
   

      vlsi2% cdsdoc & 

    Always save your work and exit Cadence before you log out. 

GNU Software- Many GNU utilities are available on VLSI2 
in the /opt/sfw/bin directory 



(2) How to start Cadence (ICFB - IC Front to Back)   
 
 
NOTE: If you have not previously set up Cadence please follow the  
   procedure in section (1) “How to set up Cadence before the first use” 
 
To start Cadence from the VLSI computer lab: 
 
Login to a workstation in the VLSI computer lab and type at the command prompt: 
 
 vlsi38%      cd cadence2 
 vlsi38%      source NCSU.cshrc_cadence2_IC5141 
 vlsi38%      icfb & 
  
To Start Cadence from the VLSI2 server:  
 
Login to vlsi2.eas.asu.edu using the SSH client from a computer on or off campus: 
Also see section (4) of this document for information on using Cadence from a PC. 
 
 vlsi2%     cd cadence2 
 vlsi2%     source NCSU.cshrc_cadence2_IC5141 
 vlsi2%     icfb & 
 
 

  
 

        Cadence documentation is available online. Just type: 
   
 vlsi2% cdsdoc & 

         How to change your password on VLSI2 
 

login with current password 
 

then type chkey –p  (to change your key) 
 

vlsi2% chkey -p 
 

When asked for your Secure-RPC password type nisplus. 
When asked for your login password type your current password. 

 
 Then change your password with the following command: 
  

vlsi2% passwd -r nisplus e525abcd 
Enter login(NIS+) password: (type your old password) 
New password:  
Re-enter new password: 
 



(3)  CADENCE Printing 
 
To print schematics you have to use the camera menu in the ICFB window. 

 
(1) From the ICFB window click on the Tools menu, then Camera, then PostScript. 
 
(2) Then in the Camera window enter a output filename, or leave the default filename  
      CameraOutput.ps, and click OK. 

 
(3) Then the cursor will become a circle. Click the circle cursor on the schematic 
        and it will make a postscript snapshot of the schematic. 
 
 

 

  
  

             To print a file on the VLSI2 server: 
 
              Use sftp  (Secure Shell FTP) or web based email to copy the CameraOutput.ps to another 
              computer and print it from there with a postscript capable program to a postscript printer 
 
 See sections (19) and (20) for more information about using Sercure Shell File Transfer. 



  (4) Using Cadence from a PC with Exceed and SSH 
   
  SSH and Exceed are installed in the Computing Commons PC labs. 
 
  If you need to Download SSH or Exceed its available from ASU IT here: 
    
   SSH Client  - http://www.asu.edu/it/security/software/html/ssh/index.htm 
 
   Note—Exceed version 9 is recommended for some older versions of Cadence 
 
   Exceed - http://www.asu.edu/it/security/software/html/xwindows/index.htm 
 
   From the PC’s start button click on: 
    
   Start—>programs—>Hummingbird Exceed—>Exceed—>Exceed 
  
   From the exceed menu click on the Exceed icon.  Exceed will start and run in the background. 
   Now use ssh to open a command prompt to VLSI2.  From the PC’s start button click on: 
 
   Start—>SSH Secure Shell—> Secure Shell Client 
 
   Click on the Secure Shell Client icon.  This will open an SSH window on your PC. 
   Now press enter or space to get a login window. Enter the following information: 
 
   Hostname: vlsi2.eas.asu.edu 
   Username: e525abcd (enter your vlsi2 username) 

 

 
 
 Now type the following at the vlsi2% prompt.  
 
 vlsi2% cd cadence2   (change to your cadence working directory) 
 vlsi2% source NCSU.cshrc_cadence2_IC5141(source environment file) 
 vlsi2% setenv DISPLAY 129.219.111.222:0.0   
  
 (replace 129.219.111.222:0.0 with the ip# number of the pc your are using) 
 (Don’t forget to add the :0.0 after the ip number) 

 
 vlsi2% icfb & (start cadence) 
 
 To find the ip number for most windows machine try this: 
 From the PC’s start button click on: 
 
 Start—>accessories—>command prompt 
 
 Click on the command prompt icon. 
 At the dos prompt type 
 



 
(5)  Troubleshooting Exceed connections on  a PC 
 
If you are working from off campus and receive the following error: 
 

*ERROR* X Window Display Initialization failure 
*WARNING* X Window Display Initialization failure 
 

You may need to skip the setenv step above in section (4). 
Then change the setting for the SSH client as follows:  

  
(a) From the ssh client window click on the EDIT menu and then SETTINGS, you will get the window in the 
picture below. 

 
(b) Then click on TUNNELING. Then check the boxes for "Tunnel X11 connections" and "Enable for SSH2 
connections" 



(6 ) How to fix screen redraw problems from a PC with Exceed 
 
 
(1) If you are using vlsi2 from a PC with Exceed and the mouse is not moving properly 
     (You might be seeing many mouse pointers at the same time) 
 
Open the Xconfig program: 
 
Start—> Programs —> Hummingbird Connectivity 10 —> Exceed —> XConfig 
 
(2) Then click on other server settings. 
 
(3) In the Performance section change the following settings: 
 
● maximum backing store (change to - always) 
 
● default backing store (change to - when mapped) 
 
● minimum backing store (change to - when mapped) 
 
(4) Then in the upper left corner choose validate and apply changes. 
 
(5) Now click on the display and video icon and change the following setting: 
 
● server visual (change to – pseudo color) 
 
(6) Then in the upper left corner choose validate and apply changes and perform a server reset if 
prompted. 



(7) Configuring Exceed Security 
 
For Exceed 10.0 perform the following configuration. 
 
Open the X Config program for Exceed: 
 
Start -> All Programs -> Hummingbird connectivity 10 -> Exceed Tools -> X Config Console 
 

 
 
(1) Click on the Security icon. 
(2) Click on the “Host Access Control List” folder. 
(3) Right Click “File” on the right half of the window and select “Edit” form the pop-up menu. 
(4) This opens a notepad editor where you can enter the hostname or IP number for servers  that you will        
be accessing with Exceed. 
 
Sample server entries for the xhost.txt file 
 
 enlnxs2.eas.asu.edu 
 vlsi2.eas.asu.edu 
 
(5) Save and Exit the xhosts.txt file in the notepad editor. 
 
(6) click on File -> Exit and close the X Config Console, save changes when prompted. 



(8)  Advanced Cadence Troubleshooting, lockfiles etc. 
 
If Icfb doesn’t start when logged into a VLSI lab workstation: (3 steps) 
 
You have logged into one of the VLSI computer lab workstations, sourced your  
cadence startup (source ncsu.cshrc) file, and then type icfb& and nothing is happening. 
 
(1) What to do: Let’s assume you are logged into VLSI07 workstation and not VLSI2 directly. 
At a command prompt type: 
 
 vlsi07% pgrep –f cadence –U e525cade 
 (Note: replace e525cade with your VLSI2 username) 
 
(If you need to open a command prompt: right click the mouse on the blue desktop background, click on the 
 tools menu, then click on terminal to open a command prompt) 
 
You will see output like this: (the numbers will be different every time) 

 
 vlsi07%  pgrep –f cadence –U e525cade 
 14076 
 11699 
 13456 
 
Stop these processes by typing at the vlsi07 prompt: 

 
 vlsi07% pkill –f cadence –U e525cade 
 (Note: replace e525cade with your VLSI2 username) 
 
(2) Now remove lock files: Type the following at the command prompt 
 
 vlsi07% clsAdminTool 
 
then you will get a “>” prompt, type the following at the prompt: 
 
 >are . ..  
(don’t forget to type the . and .. on that line with a space in between) 
 >quit 
 
Then, you should go back to the local prompt vlsi07% 
Now type: 
  
 vlsi2%  cd 
 vlsi2% rm –i CDS* (Then answer yes to delete each log and lock file) 
 rm: remove CDS.log (yes/no)? yes 
 rm: remove CDS.log.cdslck (yes/no)? Yes 
 
Continue to answer yes until you get back to the vlsi2% command prompt. 
 
(3) start cadence again 
 
 vlsi99%  source NCSU.cshrc_cadence2_IC5141 
 (or source the file used for your class if different) 
 vlsi99%  icfb &    (start Cadence) 



 

(9)   WWW Links to more information on Cadence, SSH, Exceed 
 
VLSI2 server information 
http://www.eas.asu.edu/ets/services/services/server/unix/VLSI.php 
 
NCSU Cadence web site 
http://www.cadence.ncsu.edu/ 
 
Setup for ASU VPN client 
http://www.asu.edu/it/fyi/comm/documents/vpn.pdf 
 
FREE - Virus-Scan software download from IT 
http://www.asu.edu/it/security/software/html/antivirus/index.htm 
 
FREE - SSH Client download from IT 
http://www.asu.edu/it/security/software/html/ssh/index.htm 
 
FREE - Exceed, X-window server download from IT 
http://www.asu.edu/it/security/software/html/xwindows/index.htm 
 
CSE517 - VHDL 
http://www.eas.asu.edu/~cse517a/ 
 
ETS – UNIX helpdesk FAQ 
http://intraweb.eas.asu.edu/faq/faqcat.cfm?cat_id=10 
 



(10)  Fix Netscape cookie warning messages 
  
On the netscape menus go to Edit —> Preferences. Then go to the advanced category and remove the check from 
the “Warn me before accepting a cookie” checkbox in the Cookies section. 

(11)  Text Note editor – error writing to /user/… 
 
When using text note editor (dtpad) on a Solaris box in the VLSI lab please be sure to open files from the path /
home/c517abcd/filename not the path /user/cse517/c517abcd/filename.  You do not have write permission to the /
user directory and won’t be able to save changes there. 

(12)  How to start Adobe Acrobat Reader in the VLSI lab 
  
To start adobe acrobat reader type: 
  
 vlsi30% /opt/Acrobat5/bin/acroread & 

(13) How do I check my disk space quota on VLSI2 
 
Each class account is assigned 50Mb of disk space. If you exceed this amount you will be unable to create  
new files or save changes to existing files. Please remove any unneeded files, including postscript files and  
Cadence simulation files ending with a “.tran” 
 
To check your current usage type: 
 
 vlsi2% quota –v 
 
Disk quotas for e524abcd (uid 9999): 
Filesystem     usage  quota  limit    timeleft  files  quota  limit    timeleft 
/user          22486 100000 120000                233      0      0   
 
The usage field should show 100000 or less (listed in 512k blocks) 

(14) Where are the GNU executables 
 
GNU Software – many GNU utilities are available on VLSI2 in the 
 
 /opt/sfw/bin  directory 
 
For example top is located in /opt/sfw/bin/top 



(15)  How do I use Agilent ADS on VLSI2 
 
ADS – New version 2003C located in /Tools2/ads/ads2003c 
 

        Source the file /Tools2/ads/ads2003c/ASU_readme 
 
         vlsi2% source /Tools2/ads/ads2003c/ASU_readme  
 
        and then run ads from /Tools2/ads/ads2003c/bin/ads. 
 
  vlsi2% /Tools2/ads/ads2003c/bin/ads & 
   
  Or just 
 
  Vlsi2% ads & 
 
    To view the online documentation click on the help menu: 
   
  Help —> Topics and Index 
 
    Try the Quick Start guide to begin with. 

 (16)  How to use ISE-TCAD on VLSI2 
 

  From your PC start Ssh and login to vlsi.eas.asu.edu 

  Then start Exceed HWM, click on the following from the PC’s START button 

  Start—>Programs—>Hummingbird Connectivity—>Exceed—>Exceed 

  vlsi% /bin/csh (make sure you are running the csh [c-shell]) 

  vlsi% mkdir DBtest (only do this once) 

  vlsi% setenv DISPLAY 123.123.123.123:0.0  

  (replace 123.123.123.123 with your pc’s IP number and a :0.0 on the end) 
   For TCAD v7: 
  vlsi% source /Tools/tcad/TCAD_readme_7 
  vlsi% GENESISe 
 
  For TCAD v8.5: 
  vlsi% source /Tools/tcad/TCAD_readme_8 
  vlsi% GENESISe  -rel 8.5    (NOTE: you must add "-rel 8.5") 
 
  For TCAD v9.0 
  vlsi% source /Tools/tcad/TCAD_readme_9 
  vlsi% GENESISe & 



  (18) How to use the Synopsys MC-Module Compiler 
 
1.  Make a directory called mcproj in your home directory: 
 
 vlsi2% cd  
 vlsi2% mkdir mcproj  
 vlsi2% cd mcproj  

 
2.  Source the setup file each time you run MC  
 
 vlsi2% /bin/csh (to make sure you are runing C-shell)    
 vlsi2% source /Tools/synopsys/syn/mc/localadm/setup.csh  
 
3.  Make sure your DISPLAY setting is correct:  
   
 vlsi2% setenv DISPLAY 123.123.123.123:0.0 (replace with your PC's IP address)  
   
4.  Run MC  
   
 vlsi2% mc -tech lsi_10k    (this will use the lsi10k technology)  
   
    
5.   To test MC, push the "Do All" button and MC will build an 8-bit adder as a test. 

(17) How to use HSPICE on VLSI2 
 
To use HSPICE on the VLSI2 server do the following 

 
vlsi2% source  /usr/local/synopsys2/hspice/hspice.cshrc 
vlsi2% awaves & 
 

If necessary set your display 
 
vlsi2% setenv DISPLAY 123.123.123.123:0.0 
 (Replace 123.123.123.123 with your computers ip number) 
 (Don’t forget to add the :0.0 after the ip number) 

 
Others commands available are  
 
hspicegui - to run Hspice GUI without avanwaves. 
 
hspice - to run command-line only Hspice. 
 
The HSPICE and Avan-Waves PDF documentation is available in the /usr/local/synopsys2/hspice directory on 
the VLSI2 server. 
 
 



(19) Secure file transfer to/from UNIX computers 
 
To copy files to the VLSI2 server from another computer usethe sftp command. 
 
At the command prompt type: 
 
vlsi2% sftp dilbert@general.asu.edu 
(replace dilbert with your username) 
 
Answer yes to the following question if you see it on the screen: 
 
Host key not found from database. 
Are you sure you want to continue connecting (yes/no)? Yes 
Then enter your password for the other server 
 
dilbert@general.asu.edu's password: ****** 
 
now you will see an sftp prompt. 
 
sftp> 
Type ls to see the files on the other server 
 
sftp> ls 
 
And get or put to send or receive files from the other 
server. 
 
Sftp> get test.sp (move a file from general to VLSI2) 
 
Sftp> put test.sp (move a file from VLSI2 to general) 



You can copy files to VLSI2 from a PC with the “SSH Secure File Transfer”. 
All pc’s on campus should have this program 
 
Start the SSH Secure File Transfer from a PC’s start menu 
 
Start —> All Programs —> SSH Secure Shell —> Secure File Transfer 
 
From here press the “quick connect” button and enter vlsi2.eas.asu.edu 
for the hostname and enter your vlsi2 account for the username. 
Then press the connect button. 

Then you can copy files directly from folders on the PC to 
your vlsi2 home directory in the right side on the window 
under “remote name” 

Most PC’s on campus will have SSH client and Exceed already installed. If you need to install them they are 
available from the ASU IT web site. 
 
SSH Client download from ASU IT 
http://www.asu.edu/it/fyi/comm/sw/serveraccess/ssh.html 
 
Exceed, X-window server download from ASU IT 
http://www.asu.edu/it/fyi/comm/sw/serveraccess/exceed.html 

(20) Secure Shell File Transfer from Windows PC’s 



(21) Synopsys Design Compiler and DC-FPGA Compiler 
 
First source the file from a vlsi2 command line window: 
 
source /usr/local/synopsys2/dc_fpga_2004.12/DC_FPGA.cshrc 
 
to start Synopsys documentation, called SOLD (make sure exceed is running and ssh has 
tunneling enabled. See the attached pdf) 
 
type sold at the prompt 
 
vlsi2%  sold & 
 
start the various design compiler shells: 
 
dc_shell & 
 
fpga_shell & (there is some license error with this. I'll have to email synopsys) 
 
——————- 
Synopsys On-Line Documentation  (SOLD) is available on VLSI2. 
 
(1) To start SOLD users will have to start exceed on a PC as well as have acrobat reader installed (acrobat is avail-
able on UNIX and Exceed is not needed for Solaris and LINUX) 
(2) ssh to vlsi2.eas.asu.edu.  
(3) Source the file /user2/cse518/ncsu.cshrc 
 
Then at the vlsi2 prompt type sold: 
 
Vlsi2% sold & 
 
This is version 2004.06 of SOLD 
 
If any users want to add the path to SOLD manually it is: 
 
/usr/local/synopsys2/SOLD_V-2004.06 
 
——————- 
You can register at the synopsys web page with the ASU site id which is "12904" at this link to acces more 
 documentation. 
 
https://solvnet.synopsys.com/amserver/UI/Login 
 
 


